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(1.0) Introduction 
 
(1.1) Box Contents 
 
Crimson III Drum Module          

Quickstart Guide  

Safety & Warranty Manual 

 
(1.2) Support 
 
For the latest information about this product (system requirements, compatibility information, etc.) and 
product registration, visit alesis.com. 

For additional product support, visit alesis.com/support. 

 

http://www.alesis.com
http://www.alesis.com/support
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(1.3) Setup 
 
Items not listed in (1.1) Box Contents are sold separately. 

 

(1.3.1) Connection Diagram 
 
 

Power 
Speakers* 

Smartphone, MP3 player, etc.* 

Computer* 

Use the cable snake to connect the drum module to the 
drum/cymbal pads of your electronic drum kit. 

Optional expansion tom available 
separately. 
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(2.0) Features 
 
(2.1) Top Panel 
 
 

 

 
1. LCD Display 

This displays the names and parameters of kits, sounds, songs, and menu settings. See the Display 
section for more details. 

 
 
2. F1 ~ F3 Buttons 

Press to activate the corresponding on-screen functions seen at the bottom of the display. 
 

 
3. /  Buttons 

Press to move the cursor to select a parameter on the display. 
 
 
4. Main Out Knob 

Turn to adjust the output volume for the Main Output. 
 
 

5. Aux In Knob 

Turn to adjust the input volume for the AUX In. 
 
 
6. Phones Knob 

Turn to adjust the volume for the Phones output. 
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7. Click Knob 

Turn to adjust the click volume. 
 

 
8. Play/Stop Button 

Press to start/stop playing a song. 
 
 
9. Record Button 

Press to enter Record mode. See the Recording a Song section for more details. 
 
 

10. Exit Button 

Press to return to a higher-level menu section. 
 
 

11. Menu Button 

When a Kit is displayed, press this button to enter the Kit mode menu. 

When a Song is displayed, press this button to enter the Song mode menu. 
 
 

12. Click Button 

Press to start/stop the click or edit the click setting. 
 
 

13. Coach Button 

Press to enter Coach mode. See the Coach Mode section for more details. 
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14. Data Dial 

Turn to adjust the parameter setting on the display. 
 
 

15. Song Button 

Press to enter Song mode. See the Songs section for more details. 
 
 

16. Kit Button 

Press to enter Kit mode. See the Drum Kits section for more details. 
 
 

17. -/+ Buttons 

Press to select a drum kit or increase/decrease a value on the display. 
 
 

18. Volume Faders 

Move to adjust the volume level of the upper or lower items. 
 
 

19. Volume Fader Control Button 

Press to toggle the faders between the upper and lower items. 
 
 
20. Power Button 

Press to turn the power on or o�. 
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(2.2) Rear Panel 
 

1. Power Input 

Connect the included 9V, 0.5A Center Positive power adapter here. 
 
 

2. USB MIDI  

Connect a USB-A cable from here to a computer to transmit or receive MIDI data. 
 
 

3. TOM 4, CRASH 2 (1/4” TRS) 

Connect 1/4” [6.35 mm] TRS cables here to an additional Tom or Crash cymbal. 
 

 
4. MIDI Out 

Connect an external MIDI device here to transmit MIDI data. 
 
 

5. MIDI In 

Connect an external MIDI device here to receive MIDI data. 
 
 

6. Main Output (1/4” [6.35 mm]) 

Connect these outputs to a mixer or speakers. Use both the L/MONO and R jacks for stereo output, or 
use just the L/MONO jack for mono output. 
 
 

7. Phones (1/4” [6.35 mm]) 

Connect headphones here to listen to the sound from the drum module. 
 
 

8. AUX In (1/8”) 

Connect an external audio player here for you to play along. 
 
 

9. SD Card Slot 

Insert an SD card here to play songs or load sound samples. 
 

18 19 20 24 25 26 21 23 22 
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(2.3) Display 
 

 
 

1. Menu 

Displays the current menu, such as “Kit”, “Song”, “Coach”, and “Click”. 
 
 

2. Pad Name 

Displays the selected pad name, such as “Kick”, “Snare Head”, and “Snare Rim”. 
 
 

3. Strike Strength 

Displays 8 bar segments that show the current striking strength. 
1 
9 20 24 25 26 21 23 22 

4. External Device Icon 

This icon will be illuminated when an SD card is inserted. 
 
 

5. Move Cursor Up/Down Prompt 

This area shows that the ∧/∨ buttons can be pressed to view more parameters. 
 
 

6. Parameter Details 

Displays details for the parameter settings. 
 
 

7. F1, F2, F3 Indicators 

Displays the functions for the F1 - F3 buttons. 

1 2 

3 4 

5 

6 
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(3.0) Setup 
 
(3.1) Connecting the Pads and Pedals 
 

Note: always turn off the power of all devices before making any connection. 

Use the provided cable snake and 1/4" cable to connect the pads to the Cable Snake Connector on the 
bottom panel and TRIGGER IN - CRASH 2 jack on the rear panel of the drum module. Make sure each pad is 
connected to the corresponding trigger input jack. 

Refer to the Assembly Guide included with the kit for details on assembling the drum stand, attaching drum 
pads, and connecting the drum module. 

 

 

 

 

Ride 

Crash 2 
 

Crash 1 

Tom 1 Tom2 

Tom 3 

Hihat 

Drum 
Module 

Kick 
Pad 

Snare 

Hihat 
Control 
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(3.2) Getting Ready to Play 
 

1. Connect the included power adapter to the power input on the 
drum module’s rear panel. 

2. Connect the other end of the power adapter to an appropriate 
power outlet. 

Note: Before turning on the power, make sure you have 
completed all necessary connections (pads, audio devices, etc.) 
and the volume levels of all devices are set to a minimum setting.  

3. Press the Power button to turn on the drum module. 

4. Turn on your speakers or use headphones to listen. 

5. Press the Kit button to enter the Kit menu. 

6. Use the Selection ∧/∨ buttons to select the number parameter 
next to the kit name so that its highlighted. Then use the data dial 
or the -/+ buttons to select a drum kit. 

7. Press the F1 button, selecting Sound to enter the Sound menu. 

8. Strike the pad that you want to edit. The display will show the 
current pad name and the sound name. You can also use the 
cursor dial to move the cursor to the trigger name, then use the 
data dial to select a trigger/pad. 

9. Use the cursor to move to the sound name, then use the -/+ 
button or data dial to select a sound. 

10. Adjust the Main Out Knob or Phones Knob volume while striking 
the pads until you get an appropriate volume level.  

 
 
Turning Off the Power 

1. Set the volume level of the drum module and the connected audio 
device to minimum. 

2. Turn off the connected audio device. 

3. Hold the Power button until the drum module is turned off. 
 
 
 

Auto Power Off 

In order to save energy, your drum module has the ability to 
automatically turn off after 30 or 60 minutes if it is not in use (playing, 
striking, pressing any button, etc.). You can enable or disable this 
function in the Kit > Menu > Options menu. 
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Factory Reset 

Follow these steps to reset the drum module to factory 
settings.  

1. Enter into Kit mode by pressing the Kit button. 

2. Press the Menu button entering into Kit Menu. 

3. Press the Selection ∨ button until Factory Reset is 
highlighted/selected. 

4. Press the F3/Enter button. 

5. Use the Selection ∧/∨ buttons to choose from one of the 
following Factory Reset options.  

a. Kit Reset  

b. Song Reset 

c. Trigger Reset 

d. Sound Reset 

e. All Reset 

6. Press the F3/Enter button once you have highlighted the 
item you would like to reset to its factory default settings. 
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(3.3) Playing Techniques 
 

Similar to an acoustic drum kit, the electronic drum and cymbal pads respond differently to various playing 
techniques and dynamics. 

All of the Crimson III pads are velocity sensitive. The timbre of some sounds may change depending on the 
striking strength. 

The Crimson III module supports some functionality that is not present on all included components of your 
Crimson III drum kit. For example, the included Ride pad is a triple zone ride that supports Edge, Bow, and 
Bell hits, where the crash only supports Bow hits. 
 
 
 
 
Pads: 
 
Pad: The snare and the tom can detect head shot and rim shot. The snare also 
supports cross stick. 
 
Head Shot: Strike only the head of the pad. 

 
Rim Shot: Strike the head and the rim of the pad simultaneously. Or strike only the 
rim of the pad. 

 
Cross Stick (X-Stick): When X-STICK is in use, it will produce a cross-stick sound 
when striking softly the rim of the snare, or it will produce a rim shot sound when 
striking forcefully the rim of the snare. 
 
 
 
 
 
 
 
Cymbals: 
 
Cymbal Bow Shot: Strike the middle area of the cymbal (between the bow and the 
edge). 

 
Cymbal Edge Shot: Strike the edge area of the cymbal. 

 
Cymbal Bell Shot: Strike the bell area of the cymbal. 

 
Choke Play: The crash and the ride support choke play. Just after hitting the 
crash/ride, immediately choke the edge with your hand to mute the crash/ride 
sound. 
 
 
 
 
 
 
 
 
 
 

Head 

Head Rim 

Rim 

Bow 

Edge 

Bell 

Choke 
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Hihat: 
 
Hihat Pedal Change: Press the pedal down to different positions, the sound of 
striking the hihat cymbal will change. This is similar to an acoustic hihat. 
 
Open Hihat: Strike the hihat cymbal without pressing the pedal. 
 
Closed Hihat: Strike the hihat cymbal when the pedal is fully pressed. 
 
Hihat Pedal: Press the hihat pedal (without striking the hihat cymbal) to create a 
foot-close sound. 
 
Splash: From an open position, push the pedal down to the bottom, then quickly 
release your foot from the pedal, causing the cymbal to ring out.  
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(4.0) Drum Kits 
 
(4.1) Preset Drum Kit and User Kit 
 

The Crimson III drum module provides a variety of preset drum kits 
and user kits. Select your favorite drum kit, edit the parameters, and 
then save it to a user kit. 
 
The Crimson III module supports some functionality that is not 
present on all included components of your Crimson III drum kit. For 
example, the included Ride pad is a triple zone ride that supports 
Edge, Bow, and Bell hits, where the crash only supports Bow hits. 
 
 
 
 
 
 
 
Selecting a Drum Kit 

1. Press the Kit button to enter the Kit menu. The display will show 
the current kit name, number, and volume. Press the Kit button to 
toggle between preset kit and user kit.  

2. Use the data dial or the -/+ buttons to select a drum kit. 

3. Use the Selection v button to select the volume parameter, then 
use the data dial or the -/+ buttons to adjust the kit volume. 

 
 

 

 

 

 

Function of the F1 - F3 buttons in the Kit menu: 
 

Button Function Description 

F1 SOUND Edit sound parameters. 

F2 EFFECT Edit kit effect. 

F3 XSTICK Turn X-stick on or off. 

 

In the Kit menu, press the F1 - F3 buttons to enter the related submenu. In a sub-menu, use the Selection ∧/∨ buttons to select a parameter, then use the data dial or the -/+ buttons to adjust the value. 
 
 
Editing a Kit 

1. Press the Kit button, then press the F1 (Sound) button to enter the Sound menu. 

2. In the Sound menu, you can change the pad sound and adjust sound parameters. Use the Selection ∧/∨ 
buttons to select a parameter, then use the data dial or the -/+ buttons to adjust the value. 

3. After editing the parameters, press the F3 (Save) button to save it to a user kit; otherwise the edited 
data will be lost when you change the kit. 
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Function of the F1 – F3 buttons in the Sound menu: 
 

Button Function Description 

F1 MAIN Edit main parameters of sound. 

F2 OTHERS Edit other parameters of sound. 

F3 SAVE Save the settings to a user kit. 

 
(4.2) Sounds 
 

Editing Sound Parameters (Main) 

1. Press the Kit button, then press the F1 (Sound) button to 
enter the Sound menu. The display will show the main 
parameters of the Sound menu. 

2. Strike the pad that you want to edit or use the Selection ∧/∨ 
buttons to move the cursor to the trigger/pad name, then 
use the data dial or the -/+ buttons to select a trigger/pad. 

3. Use the Selection ∧/∨ buttons to move the cursor to the 
sound name, then use the data dial or the -/+ buttons to 
select a sound. 

4. Use the Selection ∧/∨ buttons to move the cursor to the 
volume, then use the data dial or the -/+ buttons to change 
the volume level. 

 
Main sound parameters and their range: 
 

Parameter Range Description 

Sound number 1 – 471 Selects a sound number. 

Sound volume 0 – 127 Adjust the sound volume. 

 
Note: The display will show the “∧” or “∨” icon on the leftmost side when the Selection ∧ or ∨ button is 
available to use. 
 
(4.2.1) Editing Sound Parameters (Others) 

 

1. Press the Kit button, then press the F1 (Sound) button.  

2. Press the F2 (Others) button to enter the Edit menu. The display will 
show a list of sound parameters. 

3. Strike the pad that you want to edit or use the Selection ∧/∨ buttons 
to move the cursor to the trigger/pad name, then use the data dial or 
the -/+ buttons to select a trigger/pad. 

4. Use the Selection ∧/∨ buttons to select a parameter, then use the data 
dial or the -/+ buttons to change the value. 
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(4.2.2) Changing MIDI Notes 
 
To change the MIDI notes for a trigger/pad: 
 
1. Press the Kit button, then press the F1 (Sound) button.  

2. Press the F2 (Others) button to enter the Edit menu. 

3. Strike the pad that you want to edit or use the Selection ∧/∨ buttons to move the cursor to the 
trigger/pad name, then use the data dial or the -/+ buttons to select a trigger/pad. 

4. Use the Selection ∧/∨ buttons to select the MIDI note option, then use the data dial or the -/+ buttons 
to change the value. 

 

Trigger MIDI Trigger MIDI 

Kick 36  Ride Bow 51 

Snare Head 38 Ride Edge 59 

Snare Stick 37 Ride Bell 53 

Snare Rim 40 Crash1 Bow 49 

Tom1 Head 48 Crash1 Edge 55 

Tom1 Rim 50 Crash2 Bow 57 

Tom2 Head 45 Crash2 Edge 52 

Tom2 Rim 47 Hihat Bow 46/42 

Tom3 Head 43 Hihat Edge 26/22 

Tom3 Rim 58 Pedal 44 

Tom4 Head 41 Hihat Splash 21 

Tom4 Rim 39  
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Sound parameters and their range: 
 

Parameter Range Description 

Pitch -8 – +8 Adjusts the pitch. 

Pan L8 – C – R8 Adjusts the sound pan. 

Decay 0 – 5 Adjusts the sound pan. 

Reverb 0 – 127 Adjust the sound reverb level. 

MIDI Note 0 – 127 The MIDI note to be sent from MIDI Out. 

O MIDI Note 0 – 127 The open hihat MIDI note to be sent from MIDI 
Out. 

C MIDI Note 0 – 127 The closed hihat MIDI note to be sent from MIDI 
Out. 

Pad Ptn OFF, 1 – 100 Select a song number for pad pattern. When you 
strike the pad, the selected song will play back. 

Min Velocity  1 – 127  Set the minimum velocity. When your striking 
strength is smaller than this value, it will respond 
with the minimum velocity. 

Strainer OFF, ON Turn the strainer effect on or off. Only for snare 
pad sounds that have strainer effect. 

 
 
(4.3) Effects 

 

1. Press the Kit button, then press the F2 (Effect) button to enter the 
Effect menu. 

2. In the Effect menu, press the F1 (Reverb) or F2 (EQ) button to enter 
the Reverb menu or the EQ menu.  
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(4.3.1) Editing the Reverb Effect 

 

1. Press the Kit button, then press the F2 (Effect) button.  

2. Press the F1 (Reverb) button to enter the Reverb menu. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a parameter, then use the data dial or the -
/+ buttons to adjust the setting. 

 
Reverb parameters and their range: 
 

Parameter Range Description 

Type Room1, Room2, Room3, Hall1, Hall2, 
Church, Delay, Pan Delay 

Select a reverb effect. 
 

Level 0 – 127 Adjust the reverb level. 

Time 0.30s – 12.00s  Set the reverb time of these effects: 
Room1, Room2, Room3, Hall1, Hall2, Church 
 

0 – 325 ms Set the reverb time of Delay and Pan 
Delay. 

 
 
(4.3.2) Editing the EQ Effect 

 

1. Press the Kit button, then press the F2 (Effect) button.  

2. Press the F2 (EQ) button to enter the EQ menu. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a 
parameter, then use the data dial or the -/+ buttons to adjust the 
setting. 

 

EQ parameters and their range: 

Parameter Range Description 

Low Freq 50 Hz – 20000 Hz Set the cutoff frequency of the low-range. 

Low Gain -12 dB – +12 dB Adjust the gain of the low-range. 

Mid Freq 50 Hz – 20000 Hz Set the center frequency of the mid-range. 

Mid Gain -12 dB – +12 dB Adjust the gain of the mid-range. 

Mid Q 0.00 – 12.00 Set the Q value of the mid-range. The higher the 
Q value, the narrower the frequency band will be 
and there will be less frequencies affected. The 
lower the Q, the wider the Q will be and there will 
be more frequencies affected. 

High Freq 50 Hz – 20000 Hz Set the cutoff frequency of the high-range. 

High Gain -12 dB – +12 dB Adjust the gain of the high-range. 
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(4.3.3) Saving a User Kit 

 

1. After editing the sound parameters or the effect parameters, press the F3 (Save) 
button to enter the Save menu. 

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select a user kit name. 

3. Press the F3 (Enter) button to enter the Rename menu. Rename the user kit by 
using the Data Dial or +/- buttons to change the currently selected character, and 
the ∧/∨ buttons to change to the next/previous character. You can enter up to 12 
characters for each name. 

4. After renaming, press the F3 (Enter) button to save it. The display will 
temporarily show “Save Ok!”, then return to the Kit menu.  

 
 
 
Button Operation 
 

Button Operation ∧/∨ Move the cursor to the left or right. 

Data dial or </> Change the character at the cursor location. 

F1 Insert a space before the cursor location. 

F2 Delete the character at the cursor location. 

F3 Confirm and save. 

Exit Return to the previous menu. 

 
Notes: 

In the Save menu, if there’s a “*” in the user kit name, it indicate this user kit is blank. If there’s no “*” in the 
user kit name, it means this user kit has data. 

Sound and effect parameters can be edited and then saved to a user kit. The unsaved edited data will be 
lost when you change the kit or turn off the power. 

After editing kit parameters, if you do not save the edited data but directly enter Record mode, it will use 
the default kit settings for recording. 

As long as you do not change the kit, the edited sound settings will not be lost even when you go to 
another menu. 
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(4.4) Click 
 

Use the click to help you practice at a steady tempo. 

1. Press the Click button to enter the Click menu and start playing the click. 
The button indicator will blink in sync with the click sound. 

2. In Click menu, use the Selection ∧/∨ buttons to select a parameter, then 
use the data dial or -/+ buttons to change the setting. 

3. Press the Click button again to exit the Click menu and stop the click. The 
button indicator will turn off. 

Note: In the Click menu, if you press the Exit button, it will exit the Click 
menu, but will not stop the click sound. 

 
Click parameters and their range: 

Parameter Range Description 

Tempo 30 – 280 Adjust the click tempo. 

Sound Click, Clave, Stick, CoClick, FmClick, 
Voice1, Voice2 

Select the click sound. 

T-Sign 0/2 – 9/2, 0/4 – 9/4, 0/8 – 9/8, 0/16 – 
9/16 

Set the time signature. 

Interval 1/2, 3/8, 1/4, 1/8, 1/12, 1/16 Set the rhythm of the click. 

Out Phone, Main+Phone Select the output channel of the click 
sound. 
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(4.5) Songs 
 
The Crimson III drum module provides a variety of songs to select from. Try selecting your favorite songs 
and playing along with them. 
 
(4.5.1) Playing Preset Songs 

 

1. Press the Song button to enter the Song Module menu. 

2. Use the Selection ∧/∨ buttons to move the cursor to the song 
number or the volume, then use the data dial or the -/+ buttons 
to change the song number or song volume. 

3. Press the Play/Stop button to start/stop playing the song. 
During playback the display will show the measure count. 

4. When in the Song ► Module menu, press the F1 (List) button to 
enter the List menu. Then use the Selection ∧/∨ buttons, the 
data dial, or -/+ buttons to select a song from the list. 

5. When in the List menu, press the F1 (Group) button to toggle 
between the preset songs and user songs. After selecting a song 
from the list, press the Song button to go back to the Song 
menu. 

6. When in the Song Module menu or the List menu, press the F3 
(Tempo) button to show the current tempo, then use the data 
dial or -/+ buttons to adjust the tempo. 

 

 

 

 

 

 

Song groups and their range: 
 

Song Group Range Description 

Preset Ptn 1 – 100 Pattern is rhythmic music. 
When a pattern is finished, it 
will automatically start again 
from the beginning until you 
press the Play/Stop button. 

User User 101 – 110 User recorded songs 
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(4.5.2) Playing Songs from SD Card 
 

The drum module supports playing MP3, WAV, and MIDI files 
from an SD card. The default song folder on the SD card is 
“/SONG”. The drum module can recognize up to 99 songs in this 
folder. If you have more than 99 songs, create a different folder 
for the other songs. The drum module supports up to 99 folders 
in the root directory of the SD card. To play songs from a 
different folder, press the Song button, then press the Menu 
button to select a song folder for playback. 

1. Press the Song button to enter the Song menu. 

2. Insert an SD card, the display will show the SD card icon. 
Press the F2 (Card) button to enter the SD Card menu. You 
can play these song file types from the SD card: MP3, WAV, 
and MIDI. When in the SD card menu, use the F2 button to 
toggle between the SD card songs and preset songs. 

3. Press F1 (List) to enter the List menu and select a song to 
play. 

 
Notes: 

These are the format requirements when loading songs from an 
SD card: 

• MP3 Bit Rate: up to 320 kbps. Sample Rate: up to 48 kHz  

• WAV files: 16-bit. Sample Rate: up to 48 kHz 

• MIDI Format: Format 0 and 1. Up to 32 tracks 

• PPQN: Up to 480, max capacity of 128 kbytes  

• You can adjust the tempo of MIDI songs and the click, but 
cannot change the tempo of MP3 and WAV songs. 

 
(4.5.3) Playing Along with Song Playback 
 

Select a preset song or SD card song, then press the Play/Stop button to start playing the 
song. Strike the drum pads to play along with the song.  

If you are playing a preset song or a MIDI song from SD card, press the F3 (Tempo) button 
and use the data dial or the -/+ buttons to adjust the tempo. 

Press the Click button to turn the click on or off.  
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(4.5.4) Recording a Song 
 

You can enter Record mode in two ways: 

• From the Kit menu, press the Record button to 
enter Record mode. It will only record your 
drum performance. 

• From the Song menu, press the Record button 
to enter Record mode. It will record your drum 
performance and the current song. 

The operation for MIDI recording and WAV 
recording is the same. If you want to enable WAV 
recording, insert an SD card in advance. Below is an 
example of MIDI recording. 

1. Press the Record button to enter Record mode. 
By default it enables MIDI recording. The click will 
automatically turn on. To mute the click sound, 
press the Click button. 

2. In Record mode, use these buttons to adjust the 
settings for recording: 

• Use the data dial or -/+ buttons to select a 
user song slot for saving the recording. 

• Press the F1 (P-CNT) button to turn the 
count-in function on or off. 

• Press the F3 (Tempo) button to display the 
tempo value temporarily. 

• Use the data dial or -/+ buttons to adjust the 
tempo for recording. 

• Press the F2 (Card) button to enter the WAV 
recording menu. 

3. Press the Record button or strike a pad to start 
recording. In MIDI recording, the click sound will 
not be recorded. When recording WAV files, the 
click will be recorded. 

Note: During recording, only these buttons are 
available: F3 (Stop), Click, Exit, and Play/Stop.  

 

Stop and Save Recording 

1. During recording, press the F3 (Stop), 
Play/Stop, or the Exit button to stop recording. 
It will enter the Rename menu. 

2. Use the ∧/∨ buttons to rename your user song. 
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Button Operation 
 

Button Operation ∧/∨ Move the cursor to the left or right 

Data dial or </> Change the character at the cursor location 

F1 Insert a space before the cursor location 

F2 Delete the character at the cursor location 

F3 Confirm and save 

Exit Exits the Rename menu and saves the user song with the default name 
“U_Song_xx” 

 
 
Notes: 

It doesn’t support renaming a user song in WAV recording. When you stop, the recording will be saved 
using the name “SONG_xxx”. You can record up to 30 minutes in each WAV recording. 

In the Rename menu, you can enter up to 12 characters for each name. 

When a user kit is used for MIDI recording, if you change the user kit setting, when you play back this user 
song, it will sound different from recording. 

If you set the click output channel to “Main+Phone”, when in WAV recording, the click sound will also be 
recorded. 
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(4.6) Coach Mode 
 
Coach mode is a practice mode specially designed for beginners to help improve playing accuracy, speed, 
stamina, and other skills. This consists of three sub modes: Quiet Count, Beat Check, and Change Up. Score 
function is available in Beat Check and Change Up. 
 
(4.6.1) Quiet Count 
 

Quiet count helps you practice at maintaining steady timing and tempo. 
This first plays a demo, then mutes the sound so that you can practice by 
striking the pads in quiet count. 

1. Press the Coach button, then press the F1 (Quiet) button to enter the 
Quiet Count menu. 

 

Parameter Range Description 

 

001 ~ 005 Select a beat type for 
practice. 

Mode 1-1, 2-2, 1-3, 1-1 1-1: one measure of 
demo and one 
measure in quiet 
count. 
2-2: two measures of 
demo and two 
measures in quiet 
count. 
1-3: one measure of 
demo and three 
measures in quiet 
count. 

Measure Hint ON, OFF Turn the accent hint 
on or off. 

Tempo 30 ~ 280 Adjust the tempo. 

 

2. Press the Play/Stop button to start the practice. It first plays a 
count-in, then the practice starts. It first plays the demo with the click 
sound. 

When the demo stops, the click sound will be muted and “HIT!” will 
appear on the display. Strike the pad in the demonstrated tempo. 
The display will show the accuracy of each strike. During the practice, 
press the F3 (Tempo) button to adjust the tempo. 

3. Press the Play/Stop button again to stop the practice.  
 
Note: During the practice, you can track the accuracy of each strike on 
the display. 
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(4.6.2) Beat Check 
 

Beat Check provides up to 15 different beats for practice to improve your playing accuracy, with or without 
the click. Your practice will be scored when the score function is in use. 

 

 

 

 

 

 

 

 

 

 

Parameter Range Description 

 

001 – 015 Select a beat type for practice. 

Score OFF,  
ON (8Meas),  
ON (16Meas),  
ON (32Meas 

Turn the score function on or off. Select the number of 
measures for practice. 

Measure Hint ON, OFF Turn the accent hint on or off. 

Tempo 30 – 280 Adjust the tempo. 

 

1. Press the Coach button, then press the F2 (Beat) button to enter the 
Beat Check menu. 

2. Press the Play/Stop button to start the practice. It first plays a count-in, 
then the practice begins. Follow the click sound and strike the pad. The 
display will show the accuracy of each strike. During the practice, press 
the F3 (Tempo) button to adjust the tempo. 

3. Press the Play/Stop button again to stop the practice. 

Note: If you turn on the score function, when you practice for the selected 
number of measures, it will stop automatically and your practice will be 
scored. 
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Change Up 

Change Up helps to improve the skill to play with varying rhythms. It changes the beat type every two 
measures. 

 

Parameter Range Description 

 

001 – 003 Select a beat type for practice. 

Score OFF,  
ON (2 Loop), 
ON (4 Loop) 

Turn the score function on or off. 

Measure Hint ON, OFF Turn the accent hint on or off. 

Tempo 30 – 280 Adjust the tempo. 

 

1. Press the Coach button, then press the F3 (Change) button to enter the Change Up menu. 

2. Press the Play/Stop button to start the practice. It first plays a count-in, then the practice begins. The 
display will show the accuracy of each strike. Just before the beat changes, the note icon will blink on 
the display to indicate the beat will change in the next measure. During the practice, press the F3 
(Tempo) button to adjust the tempo. 

3. Press the Play/Stop button again to stop the practice. 
 
Note: If you turn on the score function, when you practice for the selected number of loops, it will stop 
automatically and your practice will be scored. 
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(4.7) SD Card 
 

When an SD card is inserted, the display will show the SD card connection icon. The drum module supports 
SD cards from 4 – 64 GB in the FAT32 format. Format (erase) the SD card on the drum module if this is the 
first time using it with the drum module. 

(4.7.1) Selecting a Song Folder for Playback 
 

The drum module can recognize up to 99 songs in a folder. The default song folder on the SD card is 
“/SONG”. If you have more than 99 songs, create a different folder for the extra songs. To play songs from 
a different folder instead of the default SONG folder, you will need to select this folder in advance. 

1. Press the Song button, then press the Menu button to enter SONG ► MENU of the SD card. 

2. By default it selects the “Song Folder”, press the F3 (ENTER) button to enter. The display will show the 
folder names. Use the Selection ∧/∨ buttons to select a folder for playback, then press the F3 (ENTER) 
button. 

 

(4.7.2) Loading a User Sound to the Drum Module 
 

You can load your favorite sound from the SD card to the drum module as a user sound. 

1. Press the Kit button, then the Menu button. Use the Selection ∧/∨ buttons to select “SD Card”, then 
press the F3 (Enter) button to enter. 

2. Use the Selection ∧/∨ buttons to select “Load Sound”, then press the F3 (Enter) button to enter. The 
display will show the WAV files in the “/ SOUND” folder on SD card. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a WAV file, then press the F3 (Enter) 
button to confirm. The display will show “Waiting...” to indicate the WAV file is being loaded to the 
drum module. The loading process may take a few minutes. 

Notes: 

Supported WAV files: Format – 16-bit, Sample Rate - 11.025k, 22.05k, 32k, 48k, 44.1k. 

Up to 99 WAV files can be placed in the “/SOUND” folder on the SD card. The total size of the loaded WAV 
files must be less than 15 MB. 

If the display shows “Unsupported file”, this indicates the WAV file format is not correct. 

Deleting or editing a single user sound is not possible. When the user sound memory is full, you can delete 
all user sounds by using the factory reset function. If a user kit included a deleted user sound, the user 
sound in this kit will become muted. 

Imported user sounds will be placed between the preset sounds and hihat combination sounds, using the 
sound number of “Uxx”. 
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(4.7.3) Loading User Kit to the Drum Module 
 

You can load a “.KIT” file from the SD card to the drum module as a 
user kit. 

1. Press the Kit button, then the Menu button. Use the Selection ∧/∨ 
buttons to select “SD Card”, then press the F3 (Enter) button to 
enter. 

2. Use the Selection ∧/∨ buttons to select “Load Kit”, then press the 
F3 (Enter) button to enter. The display will show the kit files on 
the SD card. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a kit 
name, then press the F3 (Enter) button to enter the Kit Load 
menu. 

4. Use the Selection ∧/∨ buttons or the F1/F2 button to select a 
user kit slot on the drum module. Then press the F3 (Enter) 
button to confirm and load. The display will show “Waiting...” to 
indicate the kit file is being loaded to the drum module. The 
loading process may take a few minutes. 

Notes: 

If the size of the user sound included in the selected user kit is larger than the user sound memory on the 
drum module, the display will prompt “User sound memory full!”. If this occurs, use these button operations: 

F1 (Mute): mutes the over-sized user sound and loads the selected user kit to the drum module. 

F2 (Format): erases the user sound memory on the drum module, then loads the user kit and user sound to 
the drum module. 

F3 (Exit): cancels this operation and returns to the Load Kit menu. 
 
 
(4.7.4) Saving User Kit to the SD Card 
 

You can save the current kit to the SD card as a “.KIT” file. 

1. Press the Kit button, then use the data dial or the -/+ buttons to 
select a kit, and then press the Menu button. Use the Selection ∧/∨ buttons to select “SD Card”, then press the F3 (Enter) button 
to enter. 

2. Use the Selection ∧/∨ buttons to select “Save Kit”, then press the 
F3 (Enter) button to enter. The display will show the user kit slots 
on the SD card. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a 
user kit slot, then press the F3 (Enter) button to enter the 
Rename menu. Now you can rename this user kit. 

4. Press the F3 (Enter) button to confirm and save the kit to SD 
card or press the Exit button to cancel this operation and go 
back to the previous menu. 

Notes: 

When selecting a user kit slot from SD card, if there’s an “*” icon in 
the kit name, this means the user kit is blank. If there’s no “*” icon in 
the kit name, this means the user kit has data. 

When you select a user kit slot that has data, the display will prompt 
“Overwrite The Kit File?”, indicating the saving process will overwrite 
existing data in the selected user kit. Press the F3 (Enter) to confirm 
saving or press the Exit button to cancel. 
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(4.7.5) Formatting the SD Card 
 

This operation will permanently delete all data on the SD 
card. Backup your data before formatting. 

1. Press the Kit button, then press the Menu button.  

2. Use the Selection ∧/∨ buttons to select “SD Card”, 
then press the F3 (Enter) button to enter. 

3. Use the Selection ∧/∨ buttons to select “Format SD 
Card”, then press the F3 (Enter) button to enter. The 
displays will prompt “Format the SD card? 
Exit/F3(Enter)”. 

4. Press the F3 (Enter) button to confirm or press the 
Exit button to cancel and go back to the previous 
menu. 
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(4.8) Advanced Parameters 
 
(4.8.1) Bluetooth Setup 
 
The Bluetooth Setup menu has settings to transmit Bluetooth MIDI 
or Bluetooth audio signals, reset Bluetooth pairing, and save menu 
settings. 
 
Bluetooth Audio Pairing: 
 
1. Press the Kit button, then press the Menu button.  

2. In the Pairing tab, use the Selection ∧/∨ buttons to select “BT 
Audio”. 

3. Use the the data dial or -/+ buttons to change the setting to 
“On”. Press the F3 (Enter) button to save the setting, otherwise, 
the edited data will be lost after powering off. 

4. Press the F1 (Pairing) button to begin searching for your 
Bluetooth device.  

5. On your Bluetooth device, go to your Bluetooth setting menu, 
find “Alesis Crimson III Module ”, and connect. The Crimson III 
module display will show “Bluetooth audio is connected” when 
successfully paired. 

Press the F1 (Pairing) button again disconnect from your 
Bluetooth device.  

 

 

 

Bluetooth MIDI Pairing: 

1. Press the Kit button, then press the Menu button. 

2. In the Pairing tab, use the Selection ∧/∨ buttons to select “BT MIDI”. 

3. Use the the data dial or -/+ buttons to change the setting to “On”. Press the F3 (Enter) button to save 
the setting, otherwise, the edited data will be lost after powering off. 

4. Press the F1 (Pairing) button to begin searching for your Bluetooth device. 

5. On your Bluetooth device, go to your Bluetooth setting menu, find “Alesis Crimson III Module ”, and 
connect. The Crimson III module display will show “Bluetooth MIDI is connected” when successfully 
paired. 
 

Press the F1 (Pairing) button again disconnect from your Bluetooth device. 
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(4.8.2) Trigger Setting 
 

As a drummer you may want to set the drum triggers to fit your playing style, to make your performance 
more accurate. 

1. Press the Kit button, then press the Menu button. 

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “Trigger”, then press the F3 (Enter) button 
to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a parameter, then use the data dial or -/+ 
buttons to change the setting. After editing, press the F3 (Save) button to save the setting, otherwise 
the edited data will be lost after powering off. 

 
Trigger parameters and their range: 
 

Parameter Range Description 

Head (Bow) Sensi 0 – 15 Adjusts the pad sensitivity. A high value will let the pad 
produce a loud volume even when playing softly. A low 
value will let the pad produce a low volume even when 
playing forcefully. 

Rim (Edge) Sensi* 0 – 15 Adjusts the rim sensitivity. 

Threshold 0 – 15 This setting can prevent unwanted sounding, such as 
crosstalk from other pads. Only the trigger signals that 
are above the threshold level will produce sound. If you 
set the value to a high value, it may not produce sound 
when striking softly. For example, signal B will produce 
sound but signal A and C will not. Adjust the threshold by 
first setting the value to a low level. Then increase this 
value gradually as you strike a pad. Repeat this process 
until you get an appropriate level. 

Head/Rim Adj 0 – 15 Adjust the response of head shot and rim shot (for snare 
and tom only). 

XStick Point --, 0 – 8 This sets the cross stick of the snare. A higher value 
makes it easier to produce a cross-stick sound. When the 
value is set to “0”, only a rim shot sound is produced.  

Note: This setting only works when X-Stick is turned on in 
the Kit menu. 

XTalk Cancel 0 – 15 This setting helps to avoid triggering an adjacent pad 
when a pad is hit.  

Note: If the value is set too high, when two pads are 
played simultaneously, the one that is struck less 
forcefully may not produce sound. Set this parameter to a 
lower value to prevent crosstalk. 

VibrateCancel 0 – 7 This setting helps to prevent vibration interference 
caused by closing the hihat pedal. A higher value makes it 
easier to prevent interference. 

Note: If the value is set too high, some sounds may be 
omitted when playing the hihat. 

 
*The Crimson III module supports some functionality that is not present on all included components of your 
Crimson III drum kit. For example, the included Ride pad is a triple zone ride that supports Edge, Bow, and 
Bell hits, where the crash only supports Bow hits. 
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Parameter Range Description 

Curve Normal, EXP-1, 
EXP-2, LOG-1, 
LOG-2, Loud 

The velocity curve settings adjust the sound volume 
based on how hard a pad is struck. Adjust this setting 
until the response lets you feel as natural as possible. 

RetrigCancel 0 – 15 This setting prevents “re-triggering” when a pad is hit 
only once. If re-triggering happens, increase this value 
while repeatedly striking the pad, until re-triggering no 
longer occurs. 

Note: Setting the value too high may make it easy for 
sounds to be omitted when playing drums fast (such as 
rolls). 

Close Point 0 – 2 Adjust the close point position.  
“0” = the end position. 
“1” = the middle position.  
“2” = the upper position. 

Pedal Sensi 0 – 15 Adjusts the sensitivity of the hihat pedal.  

Splash Sensi 0 – 5 Adjust the splash sensitivity. The higher value, the easier 
to achieve splash. 

Bell Sensi 0 – 15 Adjust the sensitivity of cymbal bell. 

 
 
Curve description: 
 

Curve Description 

Normal The relation between the striking force and the sound volume is linear. 

EXP1, EXP2 Soft strikes produce a small change in volume. Stronger strikes produce a big 
change in volume. 

LOG1, LOG2 Soft strikes produce a big change in volume. Stronger strikes produce a small 
change in volume. 

Loud Even soft strikes will produce a loud sound. 
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(4.8.3) Hihat Type 

 

1. Make sure the hihat is assembled as instructed in the 
Assembly Guide. 

2. Connect the drum module’s trigger cable to the hihat. 

3. Connect the drum module’s trigger control cable to the 
hihat control. 

4. Turn on the drum module, and use these procedures to set 
the hihat type. 

• Press the Kit button, then press the Menu button. 

• Use the Selection ∧/∨ buttons or the F1/F2 button to 
select “Hihat Type”, then press the F3 (ENTER) button 
to enter the setting menu. 

• Use the data dial or -/+ buttons to select the hihat 
type. 

• Press the F3 (Enter) button to save the edited setting. 
It will use this setting the next time the drum module is 
powered on. 

Setting description: 

Hihat pedal: This is the included hihat setup. Using this setting 
the hihat is controlled by a separate hihat control pedal. 

Real Hihat: With this setting the hihat is mounted on a hihat 
stand using the Alesis Real Hihat sensor. 

Note: If you want to set parameters of the real hihat control 
pedal, refer to the owner’s manual for your real hihat and set 
the parameters it recommends for it in the Trigger menu.  
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(4.8.4) Main Compressor 
 

You can limit the peak of the sound level to make the kits overall dynamics 
more consistent and balanced. 

1. Press the Kit button, then press the Menu button.  

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “Main 
Compressor”, then press the F3 (Enter) button to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a parameter, 
then use the data dial or -/+ buttons to change the setting. After editing, 
press the F3 (Save) button to save the setting, otherwise, the edited 
data will be lost after powering off. 

 
 
Compressor parameters and range: 
 

Parameter Range Description 

Threshold -30 dB – 0 dB Set the signal level at which the compressor starts 
working. 

Ratio 1 – 25 Set the compressor ratio. 

Attack 6 ms – 50 ms Set the attack time. 

Release 6 ms – 699 ms The release time before the effect. 

PreGain -60 dB – 12 dB Set the pre-gain. 
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(4.8.5) MIDI Setup 

 

1. Press the Kit button, then press the Menu button.  

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “MIDI 
Setup”, then press the F3 (Enter) button to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a parameter, 
then use the data dial or -/+ buttons to change the setting. After editing, 
press the F3 (Enter) button to save the setting, otherwise, the edited 
data will be lost after powering off. 

 

 
 
 
 
MIDI Setup parameters and their range: 
 

Parameter Range Description 

Soft Through ON, OFF MIDI data received from the MIDI IN will be transmitted to 
the MIDI Out. 

Local Ctrl ON, OFF ON: When striking a pad, the drum module will produce 
sound and send MIDI data to the MIDI Out. 
OFF: When striking a pad, the drum module’s sound will 
be muted but will send MIDI data to the MIDI Out. 

GM Mode ON, OFF ON: The MIDI IN will respond to the GM drum kit. 
OFF: The MIDI IN will respond to the local drum kit. 

ProgChange RX ON, OFF ON: Receive MIDI Program Change data on channel 10. 
OFF: Ignore MIDI Program Change data from channel 10.  

ProgChange TX ON, OFF ON: Sends MIDI Program Change data from channel 10 
when changing the kit. 
OFF: Does not send MIDI Program Change data from 
channel 10 when changing the kit. 

 
 

(4.8.6) Options 
 

Auto Power Off 

The drum module will automatically turn off after a period of time if it is not 
in use. 

Note: If you’re playing music, recording, or receiving MIDI IN data, the drum 
module will not turn off after the specified period of time. 

1. Press the Kit button, then press the Menu button.  

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “Options”, 
then press the F3 (Enter) button to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select Auto Power 
Off, then use the data dial or -/+ buttons to change the setting from Off, 
30, or 60 (in minutes). After editing, press the F3 (Enter) button to save 
the setting, otherwise, the edited data will be lost after powering off. 
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Display Contrast 
 
The contrast of the display can be adjusted to be darker or brighter: 
 
1. Press the Kit button, then press the Menu button.  

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “Options”, then press the F3 (Enter) button 
to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select Display Contrast, then use the data dial or -
/+ buttons to change the setting from 1-16. After editing, press the F3 (Enter) button to save the 
setting, otherwise, the edited data will be lost after powering off. 

 
(4.8.7) Factory Reset 
 

You can reset a user kit, user song, user trigger setting, or user sound, 
respectively. 

1. Press the Kit button, then press the Menu button. 

2. Use the Selection ∧/∨ buttons or the F1/F2 button to select “Factory 
Reset”, then press the F3 (Enter) button to enter. 

3. Use the Selection ∧/∨ buttons or the F1/F2 button to select a parameter, 
then press the F3 (Enter) button to execute factory reset. 

Note: Do not turn off the power when factory reset is in progress. If the 
power is turned off during factory reset, do the factory reset again, 
otherwise, it may affect operation. 

 

 

Parameters in the Factory Reset menu: 
 

Parameter Description 

Kit Reset Reset all user drum kits. 

Song Reset Reset all user songs 

Trigger Reset Reset all user trigger settings. 

Sound Reset Reset all user sounds. 

All Reset Reset all user kits, user songs, user trigger settings, user sounds, MIDI 
settings, Option settings and Main Compressor settings. 
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(5.0) Appendix 
 

(5.1) Kits 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 NY Maple 21 Dubstep 

2 Raw Steel 22 808 

3 Birch 23 909 

4 Sonny 24 EDM 

5 Birch 2 25 Jazz 

6 Raw Steel 2 26 Percuss1 

7 NY Maple 2 27 Indian 

8 Sonny 2 28 African 

9 Acoustic 29 Brush2 

10 Fusion 30 Orch 

11 Beatbox1 31 Percuss2 

12 Power 32 Beatbox2 

13 Live 33 Techno 

14 Reggae 34 Dance 

15 Vintage 35 World 

16 Standrd 36 R&B 

17 Funk 37 Electric 

18 Brush1 38 House 

19 Latin 39 Big Band 

20 FunkBand 40 JazLatin 
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(5.2) Sounds 
 

 
 

1 DeepBirchKick24in 43 ModCrash16in 85 Vintage Snare 

2 NYKick26in 44 CstCrash18in 86 Vintage Snare Rim 

3 SonnyKick18in 45 XCrash20in 87 Brush Snare 1 

4 SteelKick20in 46 ByzCrash18in 88 Brush Snare Rim 1 

5 CatSnare10inHead 47 ThinCrash18in 89 Brush Snare 2 

6 CatSnare10inRimshot 48 HolyChina19in 90 Brush Snare Rim 2 

7 ArtistSnare13inHead 49 SuperStacker 91 Live Snare 

8 ArtistSnare13inRimshot 50 CrispHH13in 92 Live Snare Rim 

9 OrleansSnare14inHead 51 CrispHH13inPedal 93 Orchestra Snare  

10 OrleansSnare14inRimshot 52 CrispHH13inSplash 94 Orchestra Snare Rim 

11 NCSnare14inHead 53 ProtoHH14in 95 Old School Snare 

12 NCSnare14inRimshot 54 ProtoHH14inPedal 96 Old School Snare Rim 

13 NYTom13inHighHead 55 ProtoHH14inSplash 97 R&B Snare 

14 NYTom13inHighRimshot 56 DarkHH15in 98 R&B Snare Rim 

15 NYTom13inLowHead 57 DarkHH15inPedal 99 Dubstep Snare 

16 NYTom13inLowRimshot 58 DarkHH15inSplash 100 EDM Snare 1 

17 NYTom16inHead 59 22" Standard Kick 1 101 EDM Snare 2 

18 NYTom16inRimshot 60 22" Standard Kick 2 102 EDM Snare Stick 

19 BirchTom13inHead 61 22" Jazz Kick  103 808 Snare 

20 BirchTom13inRimshot 62 Brush Kick 104 808 Snare Rim 

21 BirchTom16inHead 63 22" Acoustic Kick 105 909 Snare 

22 BirchTom16inRimshot 64 Funk Kick 106 909 Snare Rim 

23 BirchTom20inHead 65 Room Kick 107 Electronic Snare 

24 SteelTom12inHighHead 66 Power Kick 108 Dance Snare 

25 SteelTom12inHighClick 67 808 Kick 109 Dance Snare Rim 

26 SteelTom12inLowHead 68 909 Kick 110 House Snare 

27 SteelTom12inLowClick 69 Electronic Kick 111 House Snare Rim 

28 SteelTom14inHead 70 Dance Kick 112 Beatbox Snare 

29 SteelTom14inClick 71 Beatbox Kick 113 Beatbox Snare Rim 

30 AveRide21inBow 72 EDM Kick  114 Techno Snare 

31 AveRide21inEdge 73 Big Band Kick 115 Techno Snare Rim 

32 AveRide21inBell 74 Techno Kick 116 Standard Snare Stick 

33 DarkRide21inBow 75 14" Standard Snare 117 Acoustic Snare Stick  

34 DarkRide21inEdge 76 14" Standard Snare Rim 118 Funk Snare Stick 1 

35 DarkRide21inBell 77 14" Acoustic Snare  119 Jazz Snare Stick 

36 SpecialRide21inBow 78 14" Acoustic Snare Rim  120 Funk Snare Stick 2 

37 SpecialRide21inEdge 79 14" Funk Snare 1 121 Brush Snare Stick 1 

38 SpecialRide21inBell 80 14" Funk Snare Rim 1 122 Brush Snare Stick 2 

39 OHRide21inBow 81 14" Jazz Snare  123 Vintage Snare Stick 

40 OHRide21inEdge 82 14" Jazz Snare Rim  124 Live Snare Stick 

41 OHRide21inBell 83 14" Funk Snare 2 125 Beatbox Snare Stick 

42 ModCrash20in 84 14" Funk Snare Rim 2 126 808 Snare Stick 
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127 909 Snare Stick 171 Funk Tom 2 215 Electronic Tom 5 

128 Electronic Snare Stick 172 Funk Tom 2 Rim 216 Electronic Tom 6 

129 Old School Snare Stick 173 Funk Tom 3 217 Electronic Tom 7 

130 House Snare Stick 174 Funk Tom 3 Rim 218 Electronic Tom 8 

131 Techno Snare Stick 175 Funk Tom 4 219 EDM Tom 1  

132 Brush Swirl 176 Funk Tom 4 Rim 220 EDM Tom 2 

133 Standard Tom 1 177 Funk Tom 5 221 EDM Tom 3 

134 Standard Tom 1 Rim 178 Funk Tom 5 Rim 222 EDM Tom 4 

135 Standard Tom 2 179 Funk Tom 6 223 Techno Tom 1 

136 Standard Tom 2 Rim 180 Funk Tom 6 Rim 224 Techno Tom 1 Rim 

137 Standard Tom 3 181 Fusion Tom 1 225 Techkno Tom 2 

138 Standard Tom 3 Rim 182 Fusion Tom 2 226 Techno Tom 2 Rim 

139 Standard Tom 4 183 Fusion Tom 3 227 Techno Tom 3 

140 Standard Tom 4 Rim 184 Fusion Tom 4 228 Techno Tom 3 Rim 

141 Standard Tom 5 185 Fusion Tom 5 229 Techno Tom 4 

142 Standard Tom 5 Rim 186 Fusion Tom 6 230 Techno Tom 4 Rim 

143 Standard Tom 6 187 1970's Tom 1 231 Techno Tom 5 

144 Standard Tom 6 Rim 188 1970's Tom 1 Rim 232 Techno Tom 5 Rim 

145 Acoustic Tom 1 189 1970's Tom 2  233 Techno Tom 6 

146 Acoustic Tom 1 Rim   190 1970's Tom 2 Rim 234 Techno Tom 6 Rim 

147 Acoustic Tom 2 191 1970's Tom 3 235 Dubstep Tom 1 

148 Acoustic Tom 2 Rim 192 1970's Tom 3 Rim 236 Dubstep Tom 1 Rim 

149 Acoustic Tom 3 193 1970's Tom 4 237 Dubstep Tom 2 

150 Acoustic Tom 3 Rim 194 1970's Tom 4 Rim 238 Dubstep Tom 2 Rim 

151 Acoustic Tom 4 195 808 Tom 1 239 Dubstep Tom 3 

152 Acoustic Tom 4 Rim 196 808 Tom 2 240 Dubstep Tom 3 Rim 

153 Acoustic Tom 5 197 808 Tom 3 241 Dubstep Tom 4 

154 Acoustic Tom 5 Rim 198 808 Tom 4 242 Dubstep Tom 4 Rim 

155 Acoustic Tom 6 199 808 Tom 5 243 20" Standard Ride  

156 Acoustic Tom 6 Rim 200 808 Tom 6 244 20" Standard Ride Edge 

157 Brush Tom 1 201 808 Tom Fx 1 245 20" Standard Ride Bell  

158 Brush Tom 1 Rim 202 808 Tom Fx 2 246 22" Acoustic Ride 

159 Brush Tom 2 203 909 Tom 1 247 22" Acoustic Ride Edge 

160 Brush Tom 2 Rim 204 909 Tom 2 248 22" Acoustic Ride Bell 

161 Brush Tom 3 205 909 Tom 3 249 20" Rock Ride  

162 Brush Tom 3 Rim 206 909 Tom 4 250 20" Rock Ride Edge  

163 Brush Tom 4 207 909 Tom 5 251 20" Rock Ride Bell  

164 Brush Tom 4 Rim 208 909 Tom 6 252 20" Funk Ride  

165 Brush Tom 5 209 909 Tom 7 253 20" Funk Ride Edge 

166 Brush Tom 5 Rim 210 909 Tom 8 254 20" Funk Ride Bell 

167 Brush Tom 6 211 Electronic Tom 1 255 22" Funk Ride  

168 Brush Tom 6 Rim 212 Electronic Tom 2 256 22" Funk Ride Edge 

169 Funk Tom 1 213 Electronic Tom 3 257 22" Funk Ride Bell 

170 Funk Tom 1 Rim 214 Electronic Tom 4 258 Brush Ride 1 
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259 Brush Ride 2 303 Vintage Crash 1 347 Beatbox Hi-hat Pedal 1 

260 22" Big Band Ride 304 Vintage Crash 1 Edge 348 Beatbox Hi-hat 2 

261 22" Big Band Ride Edge 305 Vintage Crash 2 349 Beatbox Hi-hat Pedal 2 

262 22" Big Band Ride Bell 306 Vintage Crash 2 Edge 350 Lo-Fi Hi-hat 

263 Old School Ride 307 Latin Crash 1 351 Lo-Fi Hi-hat Edge 

264 Old School Ride Edge 308 Latin Crash 1 Edge 352 Lo-Fi Hi-hat Pedal 

265 Old School Ride Bell 309 Latin Crash 2 353 Lo-Fi Hi-hat Splash 

266 808 Ride 310 Latin Crash 2 Edge 354 Maracas  

267 Electronic Ride 311 Splash 355 Metronome Bell  

268 Electronic Ride Edge 312 Splash Edge 356 Vibra-slap 1 

269 Electronic Ride Bell 313 808Crash  357 Vibra-slap 2 

270 Dance Ride 314 909Crash 1 358 Vibra-slap 3 

271 Dance Ride Edge 315 909Crash 2 359 Synthesis Percussion 1 

272 Dance Ride Bell 316 Electronic Crash 1 360 Synthesis Percussion 2 

273 Dubstep Ride 317 Electronic Crash 2 361 Mute Hi Conga 1 

274 Techno Ride 318 Dance Crash 1 362 Mute Hi Conga 2 

275 Techno Ride Edge 319 Dance Crash 2 363 Open Hi Conga 1 

276 Techno Ride Bell 320 Techno Crash 1 364 Open Hi Conga 2 

277 Noise Ride 321 Techno Crash 1 Edge 365 Low Conga  

278 Noise Ride Edge 322 Techno Crash 2 366 High Bongo 

279 Noise Ride Bell 323 Techno Crash 2 Edge 367 Low Bongo  

280 16" Standard Crash 1 324 14" Standard Hi-hat 368 High Timbale 1 

281 16" Standard Crash 1 Edge 325 14" Standard Hi-hat Edge 369 High Timbale 2 

282 16" Acoustic Crash 1 326 14" Standard Hi-hat Pedal  370 High Timbale 3 

283 16" Acoustic Crash 1 Edge 327 14" Standard Hi-hat Splash 371 High Timbale 4 

284 16" Acoustic Crash 2 328 14" Funk Hi-hat 372 High Timbale 5 

285 16" Acoustic Crash 2 Edge 329 14" Funk Hi-hat Edge 373 Low Timbale 1 

286 18" Jazz Crash 1 330 14" Funk Hi-hat Pedal 374 Low Timbale 2 

287 18" Jazz Crash 1 Edge 331 14" Funk Hi-hat Splash 375 Low Timbale 2 Rim 

288 18" Jazz Crash 2 332 Brush Hi-hat 376 Low Timbale 3 

289 18" Jazz Crash 2 Edge 333 Brush Hi-hat Pedal  377 Low Timbale 4 

290 16" Standard Crash 2 334 Brush Hi-hat Splash 378 High Agogo  

291 16" Standard Crash 2 Edge 335 808 Hi-hat 379 Low Agogo  

292 Brush Crash 1 336 808 Hi-hat Pedal 380 Claves 

293 Brush Crash 2 337 808 Hi-hat Splash 381 Jingle Bell 1 

294 Funk Crash 1 338 909 Hi-hat 382 Jingle Bell 2 

295 Funk Crash 1 Edge 339 909 Hi-hat Pedal 383 Cowbell  

296 Funk Crash 2 340 909 Hi-hat Splash 384 Bell Tree 1 

297  Funk Crash 2 Edge 341 Dance Hi-hat 385 Bell Tree 2 

298 Orchestra Crash 1 342 Dance Hi-hat Pedal 386 Tambourine 1 

299 Orchestra Crash 2 343 Dance Hi-hat Splash 387 Tambourine 2 

300 Orchestra Crash 3 344 Dubstep Hi-hat 388 Cabasa 

301 Old School Crash 345 Dubstep Hi-hat Pedal 389 Long Guiro  

302 Old School Crash Edge 346 Beatbox Hi-hat 1 390 Short Guiro 
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391 Indian 1 432 FX 1 

392 Indian 2 433 FX 2 

393 Indian 3 434 FX 3 

394 Indian 4 435 FX 4 

395 Indian 5 436 FX 5 

396 Indian 6 437 FX 6 

397 Indian 7 438 FX 7 

398 Indian 8 439 FX 8 

399 Indian 9 440 FX 9 

400 Indian 10 441 FX 10 

401 Indian 11 442 FX 11 

402 Indian 12 443 FX 12 

403 Indian 13 444 FX 13 

404 Indian 14 445 FX 14 

405 Indian 15 446 FX 15 

406 Indian 16 447 FX 16 

407 Indian 17 448 FX 17 

408 African 1 449 FX 18 

409 African 2 450 FX 19 

410 African 3 451 FX 20 

411 African 4 452 FX 21 

412 African 5 453 FX 22 

413 African 6 454 FX 23 

414 African 7 455 FX 24 

415 African 8 456 FX 25 

416 African 9 457 FX 26 

417 African 10 458 FX 27 

418 African 11 459 FX 28 

419 African 12 460 FX 29 

420 African 13 461 FX 30 

421 African 14 462 One & Stick 

422 African 15 463 Two & Stick 

423 African 16 464 Three & Stick 

424 Orchestra Timpani E2 465 Four & Stick 

425 Orchestra Timpani F2 466 Five & Stick 

426 Orchestra Timpani Gb2 467 Six & Stick 

427 Orchestra Timpani G2 468 Seven & Stick 

428 Orchestra Timpani Ab2 469 Eight & Stick 

429 Orchestra Timpani A2 470 Nine & Stick 

430 Orchestra Timpani B2 471 Mute 

431 Orchestra Timpani C3 
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(5.3) Technical Specifications 

 
Specifications are subject to change without notice.  

 
 
(5.4) Trademarks & Licenses 
 
Alesis is a trademark of inMusic Brands, Inc., registered in the U.S. and other countries.  
The Bluetooth word mark and logos are owned by the Bluetooth SIG, Inc., and any use of such marks by Alesis is under 
license.  
All other product names, company names, trademarks, or trade names are those of their respective owners. 

 

Drum Kits 40 Factory kits / 40 User kits 

Sounds 471 

Songs 

100 Preset songs / 10 user songs 
SD card playback: up to a 64 GB card, formatted as FAT32 
Supported Files: WAV, MP3, MIDI 
Up to 99 songs in each folder 

Sequencer Normal Mode: 80 songs 

Resolution: 192 ticks per beat 

Maximum Note Storage: approximately 2000 notes per user song 

Tempo 30 - 280 BPM 

Display Backlit segment LCD 

Connectors 10-trigger 25-pin connector snake cable input 

MIDI IN 

MIDI Out 

SD card slot 

1/8" (3.5 mm) stereo Headphone output 

1/8" (3.5 mm) stereo Auxiliary input 

(2) 1/4" (6.35 mm) TRS trigger inputs: Tom 4 & Crash 2 

1/4" (6.35 mm) TRS stereo audio output 

USB-B port 

Power 9V DC, 500 mA; center-positive 

Dimensions 
(height x width x depth) 

2.9" x 10.4" x 7.1" 

74 mm x 265 mm x 181 mm 

Weight 
2.2 lbs. 

.98 kgs 
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